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1. About My Pocket

My Pocket is an application that uses Ericsson EPOC Connect to synchronize documents
between your Windows based PC and your MC 218.
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My Pocket enables you to modify your documents on both devices; everytime you reconnect
your MC 218 to your PC, My Pocket will make sure that the latest copies of your documents
are copied to or from your PC or your MC 218.

Once you have specified the bindings between your files on your MC 218 and your PC, My
Pocket can function alone and decide when your documents need synchronization.

My Pocket is composed of two main modules. A main view in which you define the bindings to
be kept synchronized and a synchronization process that shows the synchronization progress
and a log when finished. My Pocket also has a contextual help feature; press F1 at any point
during the execution of the program and the help file will give you relevant information, if
available, on the current dialog or view.

After installation, you can access My Pocket from My Ericsson on the desktop or from the
Start menu.



2. About Bindings and Synchronization

The document synchronization consists of comparing pairs of files (one file on the PC and
one on the MC 218) representing versions of the same document. A pair of such files
constitutes a Binding . During synchronization only the latest version of the document is kept;
the older version is replaced by the newest. My Pocket does not create a new document by
taking what's new in the content of each file but rather overwrites the older copy of the
document with the newest copy.

Typically, the bindings are defined once by you and later synchronized automatically by My
Pocket whenever necessary. The synchronization process may also be manually initiated by
you at any point.
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The main view of My Pocket displays the bindings you have set. This view is normally used to
define new bindings and delete or edit existing ones. Once you are done defining new
bindings or modifying existing ones, you can close this program. If you have set the auto-
synchronization option, My Pocket will maintain the synchronization process automatically.



3. System Requirements

My Pocket requires:
Microsoft Windows 95 , or
Microsoft Windows NT , or
Microsoft Windows 98 .

Ericsson EPOC Connect for the connection between your PC and your MC 218.



4. Defining a new binding

To add a new binding to the list you must start from an existing document, either on your
MC 218 or on your PC. Trigger the binding insertion operation by adding this existing
document to the main list view in one of the following ways:

+ Drag and drop from Windows Explorer or the My Ericsson window to the list;
+ Paste from a copied file in Windows Explorer or the My Ericsson window;

* Inthe File menu , click on items PC File or EPOC File;

*  On the toolbar click on corresponding buttons;

* Right-click in the existing list, click on items PC File or EPOC File

Sometimes, when a binding is defined for the first time, only one of the two files exists. In that
case, you must specify a name and location for the new parallel document. If you started from
an existing PC File, My Pocket will ask you to specify an MC 218 target file name and
location. If you started from an existing MC 218 file, My Pocket will ask you to specify a
Windows target file name and location.

The binding is then added to the list with it's default options.



5. Converting vs. Copying

Although the two files of a binding represent the same logical document, the files may not be
identical even when synchronized. This is because the formats on your MC 218 and the
format on your PC are not always the same. For example, you may have an EPOC™ Word
file on your MC 218 and a MS Word file on your PC. To make sure that you can correctly
access the documents on both devices, My Pocket can convert documents during the
synchronization process.

- WARNING -
The conversion functionality is limited to the converters installed with your Ericsson EPOC
Connect software. This means two things:

» For a given document type, there may not be any existing converter available. In this case
the document can only be copied “as is” to the parallel system and you may not be able
to access it properly on both systems;

* A document may sometime loose some of it's information in a conversion process. This is
because the target type may not be able to handle part of a document (style or object). If
you find that a particular converter is not working well with your type of document, you
may want to copy the document instead of converting it. To ensure roundtrip
synchronization at all times, you should keep your PC documents simple.

On the other hand, there may be several converters available for a given EPOC™ file type or
Windows file type. In that case, My Pocket will ask you to choose a target file type. In any
case, the type of conversion (or copy only) is defined during the creation of the binding and
can be modified in the document properties dialog box. See the Windows File Property Page
and EPOC File Property Page for more information.

During the definition of a binding, you will be asked to define the conversion behavior. If the
binding source is a Windows file, the Select type of conversion dialog  will be displayed; use
it to specify the Windows and EPOC file types. If the binding source is an EPOC file, the
target file type may be set in the Select PC Target dialog under the Save as type list box.
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Select type of conversion dialog

The Select type of conversion dialog is displayed whenever a new binding is defined from
an original PC file. Specify the document types available in this dialog to define the
conversion to apply.
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Click the Convert button to confirm the chosen types to apply.

If no types are available to suit your needs or if you want the original file to remain “as is”,
click on the Copy Only button. As a result, no conversion will be used for this binding.

If you press Cancel here, the new binding definition is aborted.



6. Binding property

When a binding is being defined, you set some of it's properties (file names locations and
types). The other properties of the binding are set using the application's default values. In all
cases, the properties of a binding can be modified after the definition of the binding. To do
this, you must access the Binding Property Sheet

Windows File Property Page

The Windows File property page shows the details of the PC side of a binding.

Item properties E1

Synchronization Fules Windows File | EFPOCFile |

—PCFile Mame and Faolder

MName: today.doc
Folder: DAFLAVHT ML WardkasterPage’,
File Twpe:  [Waord forWindows 97 j

File Size: 14336 bwtes

(0] Cancel Al

Name and Folder
Name and location of the document on the Windows environment.

File Type

Depending on the extension of the file name you have chosen, the file type list enables you to
choose the type of the file used during synchronization. This file type can serve as source file
type and/or target file type, depending on the setting specified in the Synchronization Rules
Property Page . If the binding was defined specifically without conversion, this list will be
disabled and will show the text “No conversion "

File Size
The File Size field indicates the size of the Windows file, if it already exists.



EPOC File Property Page

The EPOC file property page displays the details of the EPOC side of a binding.

Item properties E1
Synchranization Fules | Windows File EFOCFile |

—EPOC File Name and Folder

MName: today
Folder: ChiDocuments?,
File Type: |EPOCWord =]

(0] Cancel Al

Name and Folder
Name and location of the EPOC document.

File Type

The file type list enables you to choose the EPOC document type to apply during
synchronization. This file type can serve as source file type and/or target file type, depending
on the setting specified in the Synchronization Rules Property Page . If the binding was
defined specifically without conversion, this list will be disabled and will show the text “No
conversion "

Synchronization Rules

Also part of each binding's properties is a set of Synchronization rules. The next topic
explains how to access and change the synchronization rules for an existing binding and for
all new bindings.
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7. Synchronization rules

A set of synchronization rules apply to each binding. When a binding is first defined, the
default synchronization rules are applied. These rules may be accessed and modified later by
editing the binding properties. The default synchronization rules that are applied to new
bindings can also be accessed and modified. All this is done from the Synchronization Rules

property page.

Svnchronization Rules Property Page

The synchronization rules property page enables you to define a set of rules for the
synchronizer process to apply to a given binding.

This property page is present in two dialog boxes:

Binding Properties dialog box Settings that only affect the selected binding.
Options dialog box Settings saved as default settings for future
bindings.
Item properties E1

Synchronization Rules |Windgwg File | EFOC File |

—aynchronization Directian
 From MC 218 ta PC
 From PCto MC 218

* From newest to oldest

—Prompt betare Synchronization

v When hinding was synchronized within 24 hours

v When both files hawve changed since last synchronization

—Backup

¥ Keep a backup of PCfile

(0] | Cancel Al
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The Synchronization Direction  settings specify in which direction the binding shall be
synchronized. Choose one of the following settings:

From MC 218 to PC During the synchronization process, the PC file
will be overwritten only if it is older than the
corresponding MC 218 file. The MC 218 file is
never overwritten.

From PC to MC 218 During the synchronization process, the
MC 218 file will be overwritten only if it is older
than the corresponding PC file. The PCfile is
never overwritten.

From newest to oldest The older file of the two is overwritten by the
newest. This is the default option.

If your document will only be modified on your PC and the MC 218 copy is only used for
consultation, it is strongly recommended to set the From PC to MC 218 setting. Conversely, if
the document is only modified on your MC 218 and the PC copy is there for backup and/or
consultation, you should set the From MC 218 to PC setting.

The Prompt before Synchronization  setting enables you to specify whether you want to be
notified before the program decides to overwrite a file. You can be prompted in two situations:

When binding was synchronized within 24 You will be prompted if the younger file was
hours updated less than 24 hours ago with a
resolution dialog

When both files have changed since last You will be prompted if both sides of the
synchronization binding were updated since last
synchronization with a resolution dialog

The Keep a backup of PC file check box lets you specify whether you want files on your PC
to be saved to the backup folder whenever the synchronization process is about to overwrite
it.

NOTE: Even when this option is set for a particular binding, a backup of the Windows file will
only be created when the Windows file is overwritten. Therefore, if a file is always modified on
the Windows device and never on the MC 218, the synchronization process will always copy
the document from Windows to EPOC. This means that because the Windows file is never
replaced by the EPOC file, a backup would never be created.

NOTE: There is only one backup per document. This backup, when present, is kept for the file
version preceding the latest update. You cannot consult a document's version after it has
been updated twice or more.

The backups can be accessed by selecting the menu item File — Backups .
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8. Synchronizing
There are several ways to start the synchronization process.

Automatic synchronization

To make the synchronization process starts automatically, specify it in the Auto-Synch
Property Page . Synchronization will then occur at a given frequency, ensuring that your
bindings are always synchronized.

Manual synchronization

For one binding:
To synchronize one binding only, select it in the list and click on the MC 218 —
Synchronize menu item. Or, right click on the binding in the list and choose the
Synchronize menu item from the context menu.

For all bindings:
To start the synchronization of all bindings, click on the MC 218 — Synchronize All menu
item.

When a synchronization is performed, it's details are logged. This log can be viewed from the
menu item View — View Log . To see the last time the synchronization executed, look for the

Last Synchronization field in the Auto-Synchronization property page

When the synchronization process runs, a dialog displays the progress and the file name
currently being converted or copied.

8 My Pocket Synchronization

CIEN

- EpocSketch.bmp

At the end of the synchronization, a finished dialog allows you to see the log right away; in
this case you do not have to start My Pocket's main view to access the log file.

Synchronization Completed

—Syhchronization Completed
e

—Synchronization Log

% “iew Log |
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Auto-Synchronization Property Page

The Auto Synchronization property page enables you to configure automatic
synchronization between your PC and your MC 218. This property page is accessible in the
View menu under the Options... menu item.

My Pocket Options E1

Default synchranization rules  Auto Synchranization |

¥ Perform Automatic Synchronization:

—Syncronization frequency
& Each time the MC 218 is connected
" Every day

" Everyweek

Last syncronization: 31/05/99 11:27:25

(0] | Cancel Al

Use the Perform Automatic Synchronization  check box to specify whether or not you want
the synchronization process to be started automatically.

You can also set the frequency used to start the synchronization process:

Each time the MC 218 is connected The synchronization process will start every
time the MC 218 is connected with the PC.

Every day The synchronization process will
only be started automatically once
per day.
Every week The synchronization process will only be

started automatically once per week.

The Last synchronization field indicates when the process was last executed (automatically
or manually).
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Resolution Dialog — Both files h _ave changed since last synchronization

During the synchronization process, My Pocket can ask you to specify the course of action
when a specific situation is met. If, for a given binding, you choose the Prompt before
Synchronization value When both files have changed since last synchronization (in the
Synchronization Rules Property Page), the following dialog will be displayed when both
document belonging to the binding have been modified after the last synchronization of this

binding.

Both files changed since last synchronization

& Baoth sides of the hinding hawve changed since the last synchronization. Flease

indicate resolution manner;

—Windows File

Last change

O FLAYHTRML WardbdasterPageitoday.doc

31/05/99 11:44:36

—EFOCFile

Last change

C:ADocuments\today

31/05/99 11:45:02

—Resolution

 Orvernwrite older file

= | eave both files intact (do nothing);

& Crverwrite Windows file

 Crenwrite ERPOC file

The Windows File and EPOC File section display the file name and last change date and
time for the concerned documents.

In this dialog, you must choose a Resolution for this binding. Here are the four different
possibilities and their consequences:

Overwrite older file

Leave both files intact (do nothing)

Overwrite Windows file

Overwrite EPOC file

The older of the two files is overwritten by the
younger (see the dates and times of both files
above).

Both files remain in their present state.

The Windows file will be overwritten by the
EPOC file regardless of which is older.

The EPOC file will be overwritten by the EPOC
file regardless of which is older.

If you do not want this dialog to be displayed for a specific binding, go to the properties of the
binding and uncheck the option Prompt before Synchronization value When both files

have changed since last synchronization

(in the Synchronization Rules Property Page ).
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If you never want to see this option, go to the general My Pocket Options , and uncheck the
option Prompt before Synchronization  value When both files have changed since last
synchronization (in the Synchronization Rules Property Page ).

Resolution Dialog — Last synchronization was | ess than 24 hours ago

During the synchronization process, My Pocket can ask you to specify the course of action
when a specific situation is met. If, for a given binding, you choose the Prompt before
Synchronization value When binding was synchronized within 24 hours (in the
Synchronization Rules Property Page ), the following dialog will be displayed if the changed
document was synchronized less than 24 hours ago.

Last synchronization was less than 24 hours ago

& THE BINDING EETWEER
the Windows file : CAYINMTY ProfilesiflayDeskioph TMPY TestSyncro Projec
and the EFOC file: C:ADocuments', TestSynchrobProject<TimeSheet

“WWas last synchronize on: 31/05/9911:4712

Fesolutian
& Do not synchronize

" Synchronize anyway

The dialog displays the Windows and the EPOC file names as well as the date and time of
the last synchronization.

You must decide if the binding should be synchronize now or not in the Resolution section
(choose between the two answers).

If you do not want this dialog to be displayed for a specific binding, go to the properties of the
binding and uncheck the option Prompt before Synchronization = When binding was
synchronized within 24 hours  (in the Synchronization Rules Property Page ).

If you never want to see this option, go to the general My Pocket Options , and uncheck the

option Prompt before Synchronization  value When binding was synchronized within 24
hours (in the Synchronization Rules Property Page ).
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9. Disable synchronization

Disable synchronization for one or many bindings only

If you wish for My Pocket to stop synchronizing a specific (or several) document(s) without
disabling the synchronization of all other documents you can proceed in two different ways:

1. Delete the bindings regarding the documents you wish to stop synchronizing in the main
view of My Pocket;

2. For aless permanent action, you can deactivate the bindings in the main view by
unchecking the check box in the left column of the list for the line containing the binding in
the list view.
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Disable synchronization completely

If you wish to completely disable My Pocket so that it does not try to synchronize your
documents by itself, deactivate the Perform Automatic Synchronization  option from the
Auto synchronization property page in the Options dialog box.
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10. Menu commands

The File menu offers the following commands:

PC File Adds a binding based on a file on your PC

EPOC File Adds a binding based on a file on your MC 218

Explore Loads Microsoft Explorer with the folder containing the Windows file of the
currently selected binding

Launch Launch the application associated (if any) with the Windows file of the currently
selected binding

Backups Loads Microsoft Explorer with the folder containing the file backups

Properties View / Modify the properties of the currently selected binding

Exit Exits MyPocket Manager.

The Edit menu offers the following commands:

Paste Insert a binding based on a previously copied EPOC or Windows file.
Delete Delete the currently selected binding in the list

The View menu offers the following commands

Show Toolbar Check this menu item if you want the toolbar to be visible.
Show Status Bar  Check this menu item if you want the status bar to be visible.
Options... Invokes the Options dialog box.

View Log Show the last synchronization log file.

The MC 218 menu offers the following commands

Synchronize Synchronize the selected binding in the list.
Synchronize All Synchronize all active bindings.

The Help menu offers the following commands

Help Access to the contents of this help file
About My Use this command to display the copyright notice and version number of your
Pocket copy of My Pocket.
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